
 

EXCEL 
 

Première partie : Généralités-Mises en forme 
1-Démarrer :   
a) Dans "Démarrer", choisir "Programmes" pour aller cliquer sur "Microsoft Excel".  

• Un classeur Excel s'ouvre alors : il est formé de cellules à l'intersection d'une 
colonne (A, B, …) et d'une ligne (1, 2, …). Ainsi chaque cellule est repérée par ses 
coordonnées. 

• Celles de la cellule active sont indiquées dans la fenêtre (zone NOM) en haut à gauche(cellule C5 par 
exemple). Taper IV65536 à la place de C5 ( 256 colonnes et 65536 lignes) 

• Dans le menu Outils > Options > onglet Général on peut aussi numéroter les colonnes par L1C1. 
b) Les feuilles : Un classeur est composé de feuilles                         (voir en bas de l'écran).  
• Faire un ClicD sur "Feuil 1" : un menu apparaît, il permet de renommer les feuilles, de les 

déplacer, d’en insérer..  
• On peut déplacer une feuille avec la souris (capturer l’onglet, déplacer avec le bouton Gauche 

enfoncé) 
• On peut recopier une feuille avec la souris avec la touche contrôle enfoncée et faire un glisser-

déplacer avec le bouton Gauche) 
c) On peut régler la hauteur des lignes et la largeur des colonnes de plusieurs façons : 

• soit on sélectionne la ligne ou la colonne puis on va dans le menu "Format" pour sélectionner  ligne  puis 
hauteur pour y choisir la hauteur (c’est 2+hauteur en points de la police ou le nombre de caractères pour la 
largeur des colonnes). 

• soit on fait cela avec la souris: on clique dans la barre des lignes ou des colonnes, en passant sur le trait de 
séparation le curseur change  d'aspect (     ). Faire alors GlissG et régler hauteur ou largeur. 

• On peut aussi ajuster la largeur ou la hauteur par un double-clic sur la séparation des 
colonnes/lignes (après que la double flèche soit apparue) 

d) On peut ajouter lignes et colonnes : sélectionner une ligne ou une colonne par un ClicD, un menu contextuel 
apparaît, faire ClicG sur Insertion.   L'insertion se fait avant la sélection.(mais on peut choisir en passant par le menu 
Tableau > Insérer). 

2. Saisie-Format (cellules)    a) Saisir les données :  
• Pour se mettre en position de saisir du texte dans une cellule, il faut faire 2ClicG dans cette cellule (On peut 

aussi le faire dans la barre des tâches en haut de l'écran).  
• Il est possible de sélectionner une cellule par un simple ClicG puis de commencer à y saisir du texte  mais 

l'éventuel contenu de la cellule est alors effacé. 
• Pour aller à la ligne dans une cellule : faire Alt +Entrée. 
• Pour tabuler dans une cellule : faire Ctrl+Tab (  ) 

b) Saisie automatique : On peut saisir de façon automatique les jours, les mois, les dates : il suffit 
par exemple de saisir le carré noir (       devient  ) de "Janvier" dans une cellule puis de transmettre 
par GlissG aux autres cellules : mettre ainsi les 12 mois, les 7 jours de la semaine puis du 12/09/02 
au 25/09/02 sur une même ligne…etc… 

• On peut aussi saisir une suite de nombres en progression arithmétique : saisir les deux 
premiers nombres de la suite puis sélectionner les deux cellules et  appliquer la technique 
précédente sur le carré noir de la 2ème cellule. Appliquer avec (1 et 3); (18,9 et 18,5). 
Faire la même chose avec deux dates (15/09/99 et 22/09/99) par exemple. 

• Entrez un nombre dans A1 puis transmettre bouton droit enfoncé, choisir Série dans le menu… 
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c) Format d'une cellule :    
• Si le point d'insertion est dans la cellule alors ClicD amène un 

menu qui permet d'agir sur la police. 
• Si le point d'insertion n'est pas dans la cellule alors ClicD dans la 

cellule fait apparaître cette boîte à onglets. 
• Ecrire dans une cellule puis tester les différentes options. 

 
• Pour une "Bordure rapide", cliquer sur l'icône. 

 
TP :  Il s’agit de reproduire cet emploi du temps 

• Utiliser « Format de cellule » à partir du clicD 
(voir ci-dessus) 

• Utiliser Insertion > Commentaires 
• Passer par Outils > Options > onglet 

Affichage pour positionner le commentaire. 
• Impression : la prudence s’impose et il faut 

passer par Fichier > Mise en page afin de 
bien paramétrer l’impression. Votre formateur 
donnera des compléments d’information. 

3, Sélections-Déplacements :         a) Sélections : 
• Multi-Sélection : En maintenant enfoncée la touche "Ctrl", sélectionner par des ClicG successifs différentes 

cellules et ensuite avec un ClicD mettre un motif de couleur (onglet Motifs ci-dessus). Faire la même chose 
avec des lignes (ou des colonnes) par des ClicG sur 1, 2..(ou A, B...). 

• Sélectionner un rectangle de cellules : sélectionner la cellule du coin supérieur gauche du rectangle visé puis 
appuyer sur la touche MAJ et ClicG dans la cellule du coin inférieur droit. 

• Sélectionner toute la feuille avec Ctrl + A ou ClicG sur le rectangle gris en haut à gauche. 

     b) Déplacements dans une feuille :  
• Pour se déplacer d'une cellule à une autre on peut utiliser les touches de déplacement à condition que le point 

d'insertion ne soit pas dans une cellule (faire un simple ClicG dans la cellule). 
• Appuyer sur la roulette de la souris "IntelliMouse" pour voir le pointeur changer d'aspect. Le déplacement 

de la souris vous permet de vous promener dans la feuille ( lignes 1 à 65536 et colonnes A,.., AB...IV). 
• Pour atteindre directement la cellule CK5879 : aller dans le menu "Edition", sélectionner "Atteindre" puis 

dans la boîte de dialogue taper la référence de la cellule visée (CK5879 par exemple). 
• Pour atteindre l’extrémité d’une ligne ( d’une colonne) enfoncer la touche Ctrl et une des touches de 

direction (←↑→↓) 

4. Déplacer-Copier : (les contenus de cellules) 
• Pour déplacer le contenu : sélectionner la cellule, amener le pointeur au bord : ce sera 

une flèche faire ensuite un glisser-déplacer (bouton gauche de la souris enfoncé) 
• Pour recopier le contenu : faire la même chose en maintenant la touche Ctrl enfoncée. 
• On peut faire la même chose avec une ligne sélectionnée, une colonne, une plage. 
• Pour effacer le contenu : Sélectionner la cellule puis cliquer sur la touche Suppr. 
• Pour déplacer vers une autre feuille : faire comme avant mais emmener votre sélection sur le nom de la 

feuille(tout en bas) à l’aide du glisser-déplacer et avec la touche Alt enfoncée. 
• Idem pour recopier une plage sélectionnée (on enfonce les touches Alt + Ctrl. 

Emploi du temps

Lundi
Mard

i

Merc
red

i

Je
udi

Ven
dred

i

08:00 09:00
09:00 10:00
10:00 11:00
11:00 12:00
12:00 13:00
13:00 14:00
14:00 15:00
15:00 16:00
16:00 17:00
17:00 18:00

Groupe1 : excel
Groupe2 : word
Groupe3 : rien
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5. Style de cellule :  
Si on choisit souvent les mêmes mises en forme d'une 
cellule (bordure, police, motif…) il existe deux 
méthodes pour reproduire rapidement les mises en 
forme. 

• Commencer par mettre en forme une 
cellule(double bordure rouge, police "Arial 
black" de 12, motif jaune, align. à 45°) 

• METHODE 1 (valable dans un même classeur) :  
Sélectionner la cellule ainsi mise en forme, cliquer sur            Finir en cliquant dans la cellule à mettre dans ce 
style. Le double-clic sur le pinceau permet de faire des mises en forme successives. 

• METHODE 2 (style général que l'on peut appliquer dans différents classeurs). 
• Sélectionner la cellule déjà mise en forme dans votre feuille. Ouvrir le menu Format > Style. 

Saisir le nom du style (ici Monstyle) puis OK. Dans une feuille quelconque sélectionner une plage de cellules 
puis aller dans Format > Style pour sélectionner Monstyle (en haut de la boîte)...OK. 

6. Transmissions : (horizontales ou verticales) 
• Saisir un nombre dans une cellule et sélectionner cette cellule puis venir sur le petit carré noir. 
• Le pointeur devient une croix noire que l'on déplace ensuite par un GlissG : on recopie alors le contenu 

de la première cellule dans les cellules visitées. (valable quel que soit le contenu). 
• On incrémente (+1) si on enfonce la touche Ctrl pendant le déplacement (ligne ou colonne). Essayer. 
• Pour effacer : Sélectionner la plage de cellules à effacer. Capturer le petit carré noir en bas à droite puis 

"remonter vers le haut en laissant le bouton gauche enfoncé...puis lâcher. 
• Méthode rapide : Faire un double-clic sur le carré noir (en colonnes seulement et à condition que la colonne 

immédiatement à gauche soit incrémentée). 
• Taper Q1 ou Trimestre 1 ou Numéro 1 dans une cellule : 

transmettre… 
• Double transmission : écrire 2 puis 5 dans des cellules 

consécutives : transmettre (on aura 8, 11,…) 
• Ouvrir le menu des séries : mettre par exemple 3 dans une cellule et 

transmettre avec le BOUTON DROIT de la souris enfoncé, dans le 
menu qui s’ouvre cliquer sur Séries puis compléter les rubriques 
nécessaires. 

7. Ecrire dans la feuille :  
 
• Ecrire le texte (ici BONJOUR) dans une cellule quelconque (A1) 
• Ouvrir alors une « Zone de texte » à l’aide de la barre de dessin 
• Sélectionner la zone de texte et, dans la barre de formule, taper l’adresse de la cellule 

(ici A1) : « BONJOUR » doit alors apparaître dans cette zone 
• Sélectionner la « Zone de texte » et faire un clic droit sur sa bordure. 
• Dans le menu choisir Format de la zone de texte >onglet Couleurs et traits puis 

choisir les options Aucun trait et Couleur Aucune. 
• Aller ensuite dans les onglets Police et Alignement afin de mettre votre texte en 

forme 
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Deuxième Partie :  Calculs et Fonctions 
1, Les opérations (fonction calculatrice)   TOUJOURS COMMENCER PAR  = 

1) Ordre des calculs : Toute cellule peut jouer le rôle d’une calculatrice élémentaire avec (+ et -), 
multiplication et division (* et /) et les puissances (^  obtenu par Alt Gr et la touche du 9). On peut 
rappeler que ces calculs respectent les règles usuelles de priorité des opérations. Traiter  quelques 
exemples : =1+2*3 ; =(1+2)*3 ;  

=2-3^2 ; =(2-3)^2  etc… 
2) Format des nombres : Selon le contexte on peut préférer obtenir des résultats sous différentes formes 

(%, fraction, 4 décimales, notation scientifique….) : taper =1/3 dans une cellule puis quitter la cellule 
et revenir la sélectionner, faire ClicD et cliquer sur l’onglet nombre pour choisir successivement les 
principaux formats cités. Essayer de taper dans une cellule =1/2+1/3 puis Entrée et d’obtenir le 
résultat sous forme de fraction. 
• Taper votre date de naissance dans une cellule, sélectionner puis aller choisir le format Standard. 

(On aura le nombre de jours écoulés depuis le début du siècle). Combien de jours avez-vous déjà 
vécu ? 

• TRUC : Pour saisir rapidement une fraction dans une cellule. Essayer de saisir ½ (cela donnera 
01-févr). Taper maintenant dans une cellule 0 ½ (zéro-espace-1/2) et Entrée. 

Format des nombres(suite) : quelques raccourcis peuvent nous faciliter l’existence. 
• Ctrl + ; = Date du jour Ctrl + : = Heure actuelle 
• Ctrl + M = Format monétaire Ctrl + R = Format Standard 
• Ctrl + E = Format scientifique Ctrl + J = Format Date 
• Ctrl + ! = Format avec séparateur de milliers (17 238,00) 

2. Saisir une formule : 
3) Calcul littéral :  

Saisir ce qui suit puis appuyer sur la touche Entrée. 
Modifier les valeurs pour voir la mise à jour s’effectuer. En somme c’est le passage du numérique au 
littéral !! 
4) La barre des tâches : On s’intéresse, en principe, à des sommes, moyennes…par ligne ou colonne. Si 

on sélectionne les 4 cellules ci-contre (15, 10,8,11), on voit Mini=8 
dans la barre d’état (en bas à droite)  Faire ClicD à cet endroit pour 
obtenir d’autres informations (menu ci-contre). Expérimenter. 

3. Saisir une fonction : 
a) Formules « manuelles » pour ligne ou colonne : En reprenant l’exemple de 2.a) on peu taper dans la cellule E1   :  
=somme(A1 :D1) ou bien   : =moyenne(A1 :D1). Appuyer sur Entrée pour finir. 

5) Excel propose environ 300 fonctions. 
Sélectionner d’abord la cellule d’accueil du 
résultat.  

• Cliquer sur l’icône       et sélectionner l’une des 
fonctions proposées dans la boîte.  

• Coller une fonction . Finir par OK. 



Exemple : (Moyenne) Une autre boîte apparaît qui se déplace par GlissG pour permettre  
de sélectionner les cellules contenant les données (ici A1 :A4). Finir par OK. 
Le résultat s’affiche dans la cellule mais c’est la formule qui s’affiche en haut dans la barre des 
formules: 

c) Exercices   :  
• Taper 5 dans A1 et 9 dans B1 
• Taper =(A1=5) dans la cellule C1 puis =(A1=5)+0 dans D1 (VRAI ou 1…au choix) 
• Taper =(A1=5)*(B1=9) dans E1 puis =(A1=5)+(B1=9)– (A1=5)*(B1=9) dans F1  (ET puis OU) 
• Taper =((A1=5)- (A1=5)*(B1=9))+((B1=9)- (A1=5)*(B1=9))  (OU exclusif) 
• Dans les trois lignes qui suivent (colonnes A et B) modifier les valeurs puis transmettre les formules. 

d) Valeurs ou Formules ?? : Il est parfois utile de transformer des formules saisies dans une plage 
de cellules en des valeurs numériques fixes : 

• Sélectionner la cellule ou se trouve la formule, aller cliquer sur l’icône Copier. 
• Dans le menu Edition, cliquer sur Collage spécial  et cochez Valeurs puis finir par OK. 
• La formule a été remplacée définitivement par la valeur calculée (formule perdue) 
• Plus simple : Sélectionner le formule dans la barre des formules puis cliquer sur F9. 
• Pour faire basculer l’affichage Formules-Valeurs il suffit de faire Ctrl+« (touche du 3) 

4. Transmission des formules : 
Un tableur évite les calculs répétitifs en recopiant les formules en colonne (en ligne). 
Exemple : (moyenne de deux notes !) * Commencer par recopier cette plage de cellule. 

• Saisir alors le petit carré noir (en bas à droite de C1) et faire un glissG vers le bas  
• (on maintient le bouton gauche enfoncé) puis lâcher sur l’objectif (cellule C3). 
• Revenir à la position de départ (celle de l’image) :sélectionner la plage C1 :C3 et GlissG vers le haut avec le 

petit carré noir. 
AUTRE MÉTHODE : Faire 2ClicG sur le petit carré noir de la cellule sélectionnée (ici C1). 
(Marche en colonne seulement.)                    
Exercice : 

• Dans A1 saisir –3, dans A2 saisir –2,5 puis sélectionner les deux cellules. 
• Capturer le carré noir et descendre dans la colonne A jusqu’à A13 (on y obtient 3) 
• * Dans B1 écrire =exp(A1) puis 2ClicG sur le carré noir : calcul rapide des valeurs d’une fonction (entre –3 

et 3) 
Exercice :  

• Termes successifs d’une suite. Saisir 1 dans A1(ce seraU0). 
• Saisir dans A2  =racine(3+A1).  Ce sera U1. Tirer la formule vers le bas. 

Quelques fonctions 

1)Fonctions mathématiques 
 

=ABS(x) : renvoie la valeur absolue de x 
=ALEA() : renvoie un nombre aléatoire de [0 , 1[ 
=ALEA.ENTRE.BORNES(a ; b) : renvoie un nombre aléatoire entier de [a ; b[ 
=ARRONDI(x ;n) : arrondit x au nombre n de chiffres 
=COMBIN(n ;p) : nombre des combinaisons p à p de n éléments 
=DEGRES(x) : convertit x radians en degrés décimaux (ainsi =DEGRES(PI()/5) donne 36°) 
=ENTx) : retourne la partie entière de x   (=ENT(-2,5) donnera –3) 
=FACT(n) : retourne n !   et =FACTDOUBLE(n) renvoie n !! 
=LN(x) : donne le logarithme népérien   et =LOG10(x) donnera le logarithme décimal 
=LOG(x ;a) donnera le logarithme de x en base a. 
=MOD(n ;p) : renvoie le reste de la division de n par p (=MOD(28 ;5) donne 3) 
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=PGCD(a ;b ;c ;d….) : donne le PGCD de a,b,c,d…et =PPCM(a ;b ;c ;d….) donne le PPCM 
mais dans la boîte de dialogue) 
=PUISSANCE(x ;n) : renvoie x à la puissance n    
=QUOTIENT(n ;p) : donne la partie entière dans une division euclidienne 
=RACINE(x) : évident 
=RADIANS(x) : transforme les degrés décimaux en radians 
=ROMAIN(n) : transforme un entier en chiffres romains. 

2)Calculs matriciels 
 
=DETERMAT(matrice) : renvoie le déterminant de la matrice (=DETERMAT({2.3 ;4.5}) donne –2) 
=INVERSEMAT(matrice) renvoie la matrice inverse  (Résultat dans la boîte de dialogue seulement) 
=PRODUITMAT(matrice1 ;matrice2) : calcule le produit de 2 matrices 
 (=PRODUITMAT({2.3 ;4.5} ;{6.7 ;8.9}) donne {36.41 ;64.73} 
 
Méthode :  (validation par Ctr+ MAJ +Entrée) 

 Entrer la matrice comme ci-contre puis sélectionner une cellule vide. 

 Activer l’outil fonction  sur DETERMAT et entrer la plage A1 :D3 dans la 
rubrique Matrice 

 Valider par Ctrl + MAJ + Entrée au lieu du bouton de commande OK. 
 Pour le produit : entrer les 2 matrices(ex. :3x3 ) dans des 

cellules. 
 Sélectionner une plage vide 3x3 qui recevra le résultat 
 Lancer l’outil fonction sur PRODUITMAT puis entrer 

A1 :C3 dans la rubrique Matice1 et E1 :G3 dans Matrice2. 
 Valider par Ctrl + MAJ + Entrée. 

3)Fonctions statistiques (les plus courantes) 
 

=COEFFICIENT.CORRELATION(plage1 ;plage2) : renvoie le coefficient de corrélation de 2 séries se  
          trouvant dans plage1 et plage2 
=COVARIANCE(plage1 ;plage2) : covariance de 2 séries statistiques 
=DROITEREG(plage1 ;plage2) : il faut sélectionner une plage de 2 cellules (pour a et b) puis lancer la   
 fonction et saisir les plages dans Y_connus et X_connus. Finir par Ctr+ MAJ +Entrée 
=ECARTYPEP(Plage) : donne l’écart-type d’une population alors que ECARTYPE(Plage) se base sur un  
    échantillon de 30 valeurs. 

=NB.SI(Plage ; 5) : donne le nombre de 5 dans « Plage »   
=NB.SI(Plage ;  « OUI »)  Nombre des « OUI » 
 
Exercice :  

• Mettre 30 valeurs dans A1 :A30 avec =ALEA() 
• Mettre les extrémités des classes dans B1 :B5 
• Sélectionner la zone C1 :C5 puis entrer la formule 

=FREQUENCE(A1 :A30 ;B1 :B5) et valider par 
Ctrl+MAJ+Entrée…On a les effectifs des classes 

• =QUARTILE(A1 :A30 ;1) donne le premier quartile 
• =CENTILE(A1 :A30 ;0.05) donnera le 5ème centile  
• =CENTILE(A1 :A30 ;0.10) donnera le 10ème centile (1er décile) …etc…(limité à 8191 valeurs) 
• =LOI.BINOMIALE(NombreSuccès ;NombreTirages ; ProbaSuccès ;vrai-faux) 
• Les entrées sont claires : ici on calcule la probabilité de 3 succès exactement sur 10 tirages (p(succès)=1/6) 

et si on met « FAUX » dans Cumulative. 
• Si on met « VRAI » dans Cumulative on calcule la probabilité de 3 succès au plus  
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Troisième Partie : Les plages-Noms-Adressages et applications 
1. Nommer :  
Il est très utile de savoir nommer une plage de cellules (ligne-colonne-zone…) pour 2 
raisons : * Lisibilité des formules  *  Facilité de la sélection 

• Sélectionner les colonnes(puis lignes) avec 
les en-têtes puis  Insertion > Nom > 
Créer 

• Pour la colonne cocher Ligne du haut, 
pour la ligne cocher Colonne de gauche 

(c’est en général choisi par défaut) 
• Dans la zone nom les différentes en-têtes sont déclarées et il suffit de cliquer dessus pour sélectionner la plage 

des valeurs (tester) 
• Dans les formules on se servira alors des noms à la place des adresses : ainsi pour B (=Prix_article*nombre 

donne 135) puis on transmet comme d’habitude. 
• Dans une cellule quelconque =somme(Prix_article) donne 85 
. 

 Prix article nombre total 
A 1 5 5 
B 45 3 135 
C 25 7 175 
D 14 2 28 

2.Nommer une plage :  (AUTRE MÉTHODE) 
 
• Dans Insertion > Nom , choisir Définir. 
• Entrer le nom de la plage et ses références et finir par OK 
• Il suffira de cliquer sur ce nom pour sélectionner la plage. 

• Mieux : cliquer sur F5 pour atteindre la liste des noms.  
 

 3.Nommer une(des) variable(s) :  
 
Il est question d’associer un nom à une(des) cellule(s) : cette variable prendra les valeurs 
des cellules. 
 
Exemple1 : 
• Entrer x dans A1 puis sélectionner la colonne A (x prendra les valeurs de A) 
• Aller dans le menu Insertion > Nom pour choisir Créer et cocher Ligne du haut. 
• Aller dans une autre cellule pour saisir (par exemple dans B3) =2*x^2-3*x+1 
• B3 prendra la valeur 1 (x=0 par défaut) puis entrer 2 dans A2….Observer alors B3. 

 
Exemple2  
• Entrer x dans A1 et y dans B1 et sélectionner A1 :B20 
• Aller dans Insertion > Nom et choisir Créer, Ligne du haut 
• Entrer la formule =2*x^2-3*y^2 dans C2, des valeurs 

quelconques dans A2 :B20 puis recopier la formule dans la plage 
C2 :C20 !!!! 

 4.Nommer une formule  : 
 

• C’est souvent plus rapide et plus clair de remplacer une formule par un nom 
• Dans Insertion > Nom, on choisit Définir  
• On entre le nom convivial puis la formule (ici =alea.entre.bornes(1 ;49)) dans Fait Référence à…OK. 
• Utilisation dans cet exemple : entrer =loto dans une cellule. 

Exemple : On souhaite faite la moyenne des notes des 3 trimestres d’un classeur, ces notes sont dans les 
feuilles nommées Trim1, Trim2 et Trim3 dans la plage H2 :H40. On donnera le nom moyenne à la formule 
=moyenne(Trim1 :Trim3 !H2 :H40) 

 



5.UTILISATIONS de SOMMES: 
 

• Ouvrir le classeur DossierPLC1 >exo_niv1.xls > Additions 
• Sélectionner la plage A1 :A9 puis Insertion > Nom > Créer 
• Sélectionner la plage B1 :D9 et idem 
• Taper dans F1 =somme((article= « pull »)*montant) et valider 

par Ctrl+Maj+Entrée. 
• Dans F2=somme((article= « pull »)*(type=3)*montant pour 

faire une somme partielle.(avec C+M+E) 
• Dans F3=somme((article=  « pull »)*(type=3)) pour 

obtenir 2 occurrences (avec C+M+E) 
• Dans F4 =NB.SI(article ; « pull ») donne 3 pulls 
• Dans F5 =somme(N(frequence(type ;type)>0)) donnera 5 (le nombre de valeurs différentes) : ne marche que 

pour les valeurs numériques. (CME) 
• Dans F6 =NB.SI(article ;article) donnera 3 (3 fois pull qui correspond à la ligne 6)  
• Dans F7=somme(si(article<>  « » ;1/NB.SI(article ;article) ;0)) pour obtenir 5 articles différents. 
• Dans F8=somme.si(type ;3 ;montant) fait la somme des montants des articles de type 3.(CME) 
• Dans F9 =SOMME(SI(montant>PETITE.VALEUR(montant;3);montant)) qui donnera la somme des 

montants sans les 3 plus petites valeurs. (valider par CME) 
• Dans F10=somme((montant<=500)*(montant>=321)*montant) permet de faire la somme des montants 

compris entre 321 et 500. (valider par CME) 
• Dans F11=somme((montant<=500)*(montant>=321)) donne 4 montants entre 321 et 500.(CME) 
• Dans F12 =SOMME(GRANDE.VALEUR(montant;{1;2;3})) fait la somme des 3 plus grands montants 

 Somme indirecte 
• Dans la colonne A insérer des nombres (1-2-3….) : on souhaite faire les sommes A1 :Ai (i variable) 
• Construire un compteur (avec l’outil Formulaires), la valeur de ce compteur étant dans B3 
• Dans D3 mettre la formule   =SOMME(INDIRECT(« A1 :A » & B3))  la plage sommée variera avec le 

compteur. 
1    
2    

3 15
 
  120

6.CHERCHER  DANS UN TABLEAU 
 

• Dans une feuille, saisir ces données puis sélectionner la zone A1 :B8  
• Aller dans le menu Insertion >Nom > Créer pour cocher Ligne du haut. 
• Dans D1 entrer =MAX(NOTES) pour obtenir 18, la note la plus forte 
• Dans D2 entrer (pour obtenir PAUL, le nom de la plus faible note) 

=INDEX(NOMS ;EQUIV(MIN(NOTES) ;NOTES ;)) 
• Dans D3 entrer =INDEX(NOMS ;NBVAL(NOMS))  pour obtenir TOTO, 

le dernier nom. 

• Ouvrir la feuille Recherche du même classeur 
• On cherche la meilleure attaque(FAUX si on cherche la valeur exacte et 3 

car on cherche dans la 3ème colonne de la matrice A2 :C7) 
=RECHERCHEV(MAX(A2:A7);A2:C7;3;FAUX) pour Bastia 

• =RECHERCHEV(MIN(B2:B7);B2:C7;2;FAUX) pour la meilleure 
défense. 

• =RECHERCHEV(MIN(A2 :A7) ;A2 :C7 ;3 ;FAUX) pour la moins 
bonne attaque. 
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• Dans la feuille Recherche ;  taper =INDEX(A2:H2;NB(A2:H2)) s’il n’y a pas de cellule vide 
• Mais =INDEX(A3:H3;MAX(COLONNE(A3:H3)*(A3:H3<>"")))  lorsqu’il y a des cellules vides. 
• =NB.SI(A2:H2;">"&A2) : Combien de nombres > 9 dans la plage 
• =SOMME(PETITE.VALEUR(A2:H2;{1;2;3}))  somme des 3 plus petites valeurs de la plage 
• =SOMME(GRANDE.VALEUR(A2:H2;{1;2;3 ;4})) somme des 4 plus grandes 

(mettre dans A4) =RANG(A2;$A$2 :$H$2;1)  donne le rang à partir de la note la plus basse..Transmettre. 
= RANG(A2;$A$2 :$H$2;0)  donne le rang à partir de la note la plus haute..Transmettre. 
 

7. Adressage relatif-absolu : 
a) Notion fondamentale dans un tableur. Un petit exemple va nous permettre de comprendre.  

• Taper 1 dans la cellule A1 puis =3+A1 dans la cellule A2, ensuite transmettre (technique déjà étudiée) la 
formule de la cellule A2 aux cellules A3:A8. L'adressage est relatif (dans A3 nous aurons 3+A2=7...). 

• Taper 1 dans la cellule B1 puis =3+B$1 dans la cellule B2, transmettre aux cellules B3:B8. L'adressage est 
alors absolu (ligne 1) et le résultat sera toujours 3+1=4. 

b) Exercice : Nous avons des prix HT en francs(Fr) et nous voulons calculer les prix TTC en francs puis en euros. 
Dans la cellule A1 insérer 1,206 (TVA à 20,6%) et dans A2 entrer 6,55 (1 E=6,56 Fr). Entrer des prix HT en francs 
dans les cellules B1:B5 (100; 250; 48; 770; 1340). Calculer les prix TTC en Fr dans la colonne C puis en E dans la 
colonne D. 

8. Les moyennes :     

a) Moyenne arithmétique :    (lorsqu’une cellule est vide, il n’en est pas tenu 
compte dans la moyenne) 
b)Moyenne pondérée sans absences :  
• Ouvrir le classeur Dossier PLC1 > Base.xls  
• Taper dans la cellule J2 la formule =SOMME(B2 :I2*B$18 :I$18)/SOMME(B$18 :I$18) 

• Il faut mettre des $ devant les lignes pour rendre leur numéro absolu 
(référence aux coefficients) 

• On peut les mettre « à la main » ou utiliser la touche F4 (on sélectionne 
d’abord la formule à dollariser) 

• Finir par Ctrl + Maj + Entrée pour faire un calcul matriciel puis 
transmettre à J3 :J17 

b) Moyenne pondérée avec absence :(les absences seront les cases vides) 
=SOMME(A2 :D2*$A$1 :$D$1)/SOMME.SI(A2 :D2 ; « <> » ;$A$1 :$D$1) 

• Faire un tableau de notes avec une ligne consacrée aux coefficients. 
 
• Dans E2 entrer la formule (les accolades se mettront automatiq.) :  
• Valider cette formule par un Ctrl + Maj + Entrée. 
• Transmettre à la colonne E2 :E5 et mettre les résultats dans un format du style (10,54 par exemple) avec un 

Ctrl + ! 
 

c) Exercice:  
Ouvrir dans "DossierPLC1" le fichier "Bac.xls" et la feuille "Trimestre1-97" 
• Faire les moyennes pondérées dans la colonne K. 
• Faire les moyennes par matière dans la ligne 19 et les écarts-types dans la ligne 20. 
• Attribuer l'une des mentions (X si note<8; O si note <=10 puis P si note>10) à l'aide de la formule : 
• =SI(K3<8;"X";SI(K3<10;"O";"P")) dans la colonne L. 
• faire correspondre un classement pour chaque élève en fonction de son résultat : dans la cellule M3, taper la 

fonction =RANG(K3; K$3:K$18).   (K$3:K$18 est la référence absolue de l'ensemble des moyennes). 
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Quatrième Partie : Les graphiques 

Excel est un tableur-grapheur : il permet de faire des représentations graphiques afin de mettre en valeur une série de 
données, de faire des comparaisons, de suivre des évolutions. 
1. Création rapide d'un graphique :  
• Ouvrir dans le DossierPLC1, le fichier exerc.xls puis la feuille exo1. 
• Aller dans Fichier puis Enregistrer sous pour enregistrer ce classeur dans le dossier MonPrénom sous le nom 

Monessai 
• Sélectionner la plage A1 :E6 puis cliquer sur la touche de fonction F11 : c’est fini, dans la feuille Graph1 vient se 

placer votre graphique de façon automatique. Cliquer sur          pour enregistrer les modifications. 

2. Modification d'un graphique : (Travailler sur le classeur Monessai) 
• Toute modification des données entraîne une mise à jour automatique du ou des graphiques concernés. 
• Par les techniques habituelles on peut déplacer ou redimensionner le graphique. 
• Par 2ClicG sur une zone du graphique, sur le fond, sur des éléments graphiques on fait apparaître des boîtes de 

dialogue pour y choisir couleur, épaisseur... 
• Par un ClicD sur différents éléments pour faire apparaître des menus 

contextuels qui permettent de transformer le graphique. Essayer en 
particulier ClicD sur une série de données, explorer les différents onglets. 
(en particulier Etiquettes et les Options qui permettent de choisir 
écartement/superposition des barres) 

• Pour finir choisir un graphique 3D puis faire ClicD sur une série de données puis ClicG sur Format de la 
série…Explorer les différents onglets et en particulier Options (pour modifier les dimensions) 

3. Tracé d’une courbe 
• Sélectionner les colonnes des abscisses et ordonnées (exp(A1)) 

• Cliquer sur            pour lancer un assistant graphique 

• Choisir les nuages de points puis ce type de 
graphique 

• Cliquer sur Terminer pour achever le travail. 

• Il est possible de tracer une 2ème courbe sur le même 
graphique avec un Copier-Collage Spécial. 

4. Création d'un graphique : (Choix à priori des options: voir la page 5 des copies d’écrans) 
 
• Sélectionner la plage   A1 :E6 (même données que ce qui précède) 

• Cliquer sur cette icône         pour ouvrir une première boîte de dialogue. 

• Dans la boîte de dialogue choisir "courbes"                   puis le type de courbe (col1-lign2). 

• Cliquer sur "Suivant" tout en bas et choisir l’option Lignes (c’est mieux ici). ClicG sur Suivant. 

• On peut alors mettre un titre et paramétrer le graphique, finir par "Suivant" et choisir l'option 
"Sur une nouvelle feuille" , cliquer sur "Fin" (voir copies d'écran page 6). 

 

ON PEUT CLIQUER A TOUT MOMENT SUR              POUR REVENIR SUR SES CHOIX DANS LES BOÎTES DE DIALOGUE 

 



 
 
 
 

Première boîte  Suivant 
(On choisit le type de courbes) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Deuxième boîte  Suivant 
(Disposition ligne/colonne) 
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Troisième boîte   
Mettre un titre…(facultatif) 
S i t

 

Quatrième boîte    Fin 
Choisir "sur une nouvelle feuille" 
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5. Applications : 
• On revient dans la feuille exo1 du classeur exerc.xls 

Mettre dans B10 : E10 les devoirs D1, D2, D3, D4 
puis dans A11 :A14 (Mini, Maxi, Moyenne, Julie). 

• Dans B11 saisir la formule =min(B2 :B6) puis 
transmettre dans la ligne. 

• Dans B12 saisir =max(B2 :B6) puis transmettre à la 
ligne. 

• Dans B13 saisir =moyenne(B2 :B6) puis 
transmettre à la ligne. 

• Recopier la ligne B6 dans la ligne B14. 
• Sélectionner la plage A10 :E14 et pour finir cliquer 

sur F11. 

 
• L’objectif immédiat sera de modifier le 

graphique initial standard pour le 
transformer en celui-ci à l’aide des 
différents outils à disposition.  

• Faire ClicD sur la série « Julie » puis 
Type de 
graphique pour 
changer seulement 
la courbe de Julie en 
ce type 

d’histogramme. Ne pas oublier de 
cocher : 

 
 
• Revenir dans exerc.xls > feuille exo1 pour 

faire une multi-sélection : en maintenant la 
touche Ctrl enfoncée venir cliquer sur les 
numéros des lignes 1, 3, 6. Cliquer sur F11 
pour obtenir un graphique de base. 

• L’objectif à présent est d’obtenir le 
graphique ci-contre (voir la feuille 
Graphexo3) 

• Ouvrez DossierPLC1 > exerc.xls et la feuille exo4. Sélectionnez A1:L2. Cliquez sur F11. 
• L’objectif sera alors de modifier le graphique standard pour obtenir le graphique de la feuille Graphexo4. 
• Choisir Ce type de nuage de points :  

 
 
• Faire ClicD sur un point du nuage puis : 
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6.Courbe de régression  
 

• Ouvrez DossierPLC1 > exerc.xls et la feuille exo4. Sélectionnez A1:L2.  
• Choisir Ce type de nuage de points :  
• Faire ClicD sur un point du nuage puis : 
 

7.Tracer plusieurs courbes sur un même graphique 
• Mettre x  en A1 puis sélectionner la colonne A et dans le menu 

Insertion>Nom>Créer , choisir Ligne du haut 
• Mettre -2 et -1,8 dans A2 :A3 puis copier vers le bas(…2,6 ; 2,8 ; 3). Saisir 

=exp(x) dans B2 et propager. 

• Tracer avec  une première courbe (Nuages de points) avec ce type de 
nuage.(ici y=exp(x) : on sélectionne la plage A2 :B27) 

• Dans C2 saisir =x^2 et propager dans 
C2 :C27. 

• Sélectionner le graphique et lancer 

l’assistant  puis Ajouter une série à 
l’étape 2 et choisir ces valeurs. 

8.Animer ce graphique 
MÉTHODE 1 : (AVEC UN COMPTEUR) 
• Construire avec Barre d’outils > Formulaires un compteur 
• ClicD dessus et choisir dans Format de contrôle du menu Min=0 ; Max =5 et Cellule liée=D1 
• Dans D2 mettre =(D1-2)/10 (défilement de pas 0.1 de -2 à 3) 

• Dans D3 mettre =exp(D2)….pour finir par construire une Série3 avec  
• Finir par mettre en forme ce point isolé pour le voir mieux…Tester avec le compteur. 
 
MÉTHODE 2 :  (AVEC UNE MACRO) 
• Passer dans VBEditor (Alt F11) puis Insertion > Module  
• et taper ce code : 
• Revenir dans le classeur (Alt + Q)  
• Insérer une « forme automatique »  
• Faire ClicD dessus pour y mettre un titre et lui  

Affecter une macro  (TracePoint) 
• Cliquer sur ce bouton pour tester. 
 

9.Transformer un graphique en image 
 

 Sélectionner le graphique et le Couper. 
 Aller dans Edition pour faire un Collage spécial. 
 On a une image au format *.wmf. 

TracePoint
Sub TracePoint() 
débutN = -2 
finN = 3 
pasN = 0.01 
Range("d5").Select 
Range("D5").Value = débutN 
For i = débutN To finN Step pasN 
Cells(5, 4).Formula = i 
Range("a3").Select 
Next i 
End Sub
e 4/5 09/09/2004 



10.Tracés de surfaces planes dans l’espace 
 
• Il est possible de tracer très facilement des surfaces avec Excel, voici quelques exemples tirés des programmes 

de 1ère ES et Ter ES. 
• Ainsi on veut représenter le paraboloïde de révolution 

d’équation z =x² + y²   
 

• Mettre –5, -4, …,4, 5 dans la plage A2 :A12 
• Mettre –5, -4, …,4, 5 dans la plage B1 :L1 
• Dans B2 saisir la formule : =$A^2+B$1^2 et transmettre à B2 :B12 puis à toute la plage B2 :L12 

• Sélectionner la zone A1 :L12 puis  et choisir les options  et  
• Aussitôt vous obtenez la surface désirée. 
 

-5

-3

-1 1

3

5-5 -4 -3 -2 -1 0 1 2 3 4 5
0

5

10

15

20

25

30

35

40

45

50
45-50
40-45
35-40
30-35
25-30
20-25
15-20
10-15
5-10
0-5

   
• On peut obtenir une projection dans le plan (xOy) avec la même sélection : il suffit d’opter 

pour ce type de représentation. 
• Représenter les surfaces dont les équations sont : 

 z=(-x²-y²+6x+8y)/5 avec x∈[0 ;8] et y ∈[0 ;10] 
 le plan d’équation z=10-x-y et x∈[0 ;10] et y ∈[0 ;10] 
 le cône d’équation z=rac(x²+y²) et x∈[-5 ;5] et y ∈[-5 ;5] 
 z=5/(1+x²+y²) et x∈[-5 ;5] et y ∈[-5 ;5] 
  

-5 -4 
-
5

=$A2^2+B$
1^2 =$A2^2+C$1^2 

-
4

=$A3^2+B$
1^2 =$A3^2+C$1^2 

11.Faire tourner ces surfaces avec des macros 
 
• Passer dans VBEditor (Alt F11) puis Insertion > Module  
• Taper le code ci-contre 
• Revenir dans le classeur (Alt + Q)  
• Insérer une « forme automatique »   
• Faire ClicD dessus pour y mettre un titre et lui  

Affecter une macro  (rot2) 
• Cliquer sur ce bouton pour tester.(on tourne de 5° 

autour d’un axe vertical. 
 

• Il suffit de faire 4 macros (presque) identiques  
• Pour faire une rotation d’axe horizontal (remplacer 

Rotation par Elevation dans le code) 
• Aller voir l’effet dans DossierPLC1 > Espace 
 

Sub rot2() 
    ActiveSheet.ChartObjects("Graphique 
1").Activate 
    ActiveChart.Corners.Select 
    x = ActiveChart.Rotation 
    If x > 5 Then 
    x = x - 5 
    With ActiveChart 
        .Rotation = x 
    End With 
    Else 
    x = 359 
    With ActiveChart 
    .Rotation = x 
    End With 
    End If 
End Sub 
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Cinquième partie : Listes de données - Gestion de classes  
Excel n'est pas vraiment fait pour cela mais avec les "listes", il offre quelques fonctionnalités d'une base de 

données. C'est donc l'occasion de s'initier au vocabulaire et aux fonctions élémentaires de ces bases. 
1. Saisie par masque :  
 
c) Le masque :  
• Ouvrir un classeur vierge  
• Écrire les titres en ligne des différentes rubriques à saisir . 
• Sélectionner les cellules contenant ces titres puis dans le menu 

"Données" cliquer sur "Grille pour afficher le masque. 
b) La saisie :  Il suffit maintenant de remplir les fiches pour voir les lignes 

de notre base se remplir (les différents boutons permettent de passer d'une 
fiche à l'autre : Précédente et Suivante, d'en créer avec Nouvelle, d’en 
Supprimer). 
 
c) Exercice  :  
• Ouvrir DossierPLC1 > Base.xls puis cliquer dans A1. 
• Dans le menu "Données" cliquez sur "Grille". On peut consulter ainsi rapidement les 

fiches de cette base de données. 
• Rechercher une fiche : Dans la grille cliquer sur "Critères"  puis entrer "Alain" dans la zone 

"Prénom" 
• Finir en tapant "Entrée" pour faire apparaître les fiches des "Alain" 
• Taper B* dans la zone NOM pour obtenir toutes les fiches des personnes dont le nom commence par B. 
• Finir par Fermer dans la grille . 
•  

2. Trier-Filtrer-Ordonner : 
On revient dans le fichier "BASE.xls" qui nous permettra de faire quelques essais supplémentaires. Lorsque vous 

fermerez ce fichier n'enregistrez JAMAIS les modifications.(répondre NON) 
a) Trier :              

• Ces deux boutons permettent des tris alphabétiques ou numériques (croissants ou décroissants). 
Il faut faire ATTENTION : le tri ne portera que sur la (les) colonne(s) sélectionnée(s) 

• Dans le menu "Données" > "Trier" on peut faire un tri moins grossier à l'aide de boîtes de dialogue. Amusez-
vous à faire quelques essais sur la liste qui est ouverte....(voir d)) 

b) Filtrer : Se placer dans A1 puis dans le menu "Données" choisir "Filtre > Filtre automatique" pour voir ceci: 
 
En cliquant sur les petites flèches, les entrées de la colonne sont affichées. Exemples : 
• Cliquer sur la petite flèche de "Prénom" pour voir le menu ci-contre et choisir "Andrée".  
• Seules les deux lignes qui correspondent à Andrée s'afficheront. 
• Cliquer sur "Tous" pour rétablir la liste complète puis par une méthode analogue trouver toutes 

les notes 12 puis la date du 22/01/97. 
• Si on ne revient pas (avec Tous) à la liste principale les critères de recherche se cumulent pour affiner la 

recherche. 
• Cliquer sur la petite flèche de Notes  puis sur (10 premiers...) et choisir Haut pour finir par OK. Les 10 notes 

les plus hautes vont s'afficher. Faire d'autres essais(À CHAQUE FOIS RÉTABLIR LA BASE COMPLÈTE EN CLIQUANT 
SUR TOUS). 

c) Filtre personnalisé (* remplace un groupe de lettres, ? Une lettre) 
• Faire apparaître le menu des filtres de "Etablissement" et choisir 

"Personnalisé" puis taper "Collège*". 
• Finir par OK. 
• Chercher ceux ayant plus de 15 en Collège ou moins de 05 
• Chercher les dates postérieures au 01/02/97 
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d) Trier 

 Revenez dans la base de données et 
allez dans Données > Trier pour trier 
par Ville 

• Vos fiches sont classées par Ville : on 
va faire les moyennes par Ville. 

• Allez dans le menu Données > 
Sous-totaux puis choisissez les mêmes 
options que dans cette boîte « Sous-

total »Il suffit de 

e) Grouper lignes et colonnes 
 
• Il est possible de regrouper lignes ou colonnes et les plier ou déplier au fil des besoins. 
• Sélectionner les lignes ou colonnes à replier puis  
• Aller dans le menu Données > Grouper et créer un plan et cliquer sur Grouper. 
• Il suffit à présent de cliquer sur + ou – pour plier ou déplier les lignes ou colonnes.  

3) Volets de visualisation  
 
• Ils permettent de visualiser plusieurs parties d’une feuille 

simultanément.  
• Capturer cette poignée pour la déplacer avec le 

bouton gauche de la souris enfoncé.  
• Il est très pratique de placer les deux barres à la limite de la 

première ligne d’en-têtes et de la première colonne des noms puis dans le menu  Fenêtre il faut Figer les 
volets : quelles que soient les dimensions du tableau la première ligne et la première colonne resteront visibles. 

 
4) Liste automatique personnelle : . 
 
• Ouvrir Dossier PLC1 > Base.xls et sélectionner votre liste de NOMS dans A2 :A34 
• Aller dans Outils > Options". Choisir l'onglet                                  puis Importer et finir par OK. 
• Tester cette nouvelle liste (saisir un élément de la liste, GUY par exemple, puis « tirer ») 
• Autre méthode : Cliquer sur "Ajouter" et taper directement la liste dans la boîte.  
• REVENIR DANS LA BOÎTE PUIS SUPPRIMER LA LISTE AINSI CRÉÉE. 

5)Les listes déroulantes : (ouvrir un nouveau classeur) 
• Dans la Feuil2, saisir dans les cellules A1 :A5 : PLC1-PLC2-CAPLP2-PE1-PE2.

Revenir dans la feuille Feuil1 
 
• Dans la barre Formulaires faire ClicG sur Zone de liste modifiable. 
• Construire l'objet avec GlissG puis faire ClicD sur l'objet pour ouvrir 

Format de contrôle. 
• Placer le point d'insertion dans "Plage d'entrée" puis retourner dans 

Feuil2 pour y sélectionner la plage A1-A5. 
• Revenir dans Feuil1 et la boîte : entrer $E$4 dans "Cellule liée" (toute cellule convient) 

et finir par OK. 
Tester la liste : votre sélection affichera 1 à 5 dans la cellule E4 

 



6) Exercices:  
 a) Liste déroulante d’élèves 

• Commencer par ouvrir DossierPLC1 > graph1.xls > et la feuille Listes 
• Aller dans Affichage > Barres d’outils > Formulaires (ouvre la barre des formulaires) 
• Cliquer sur l’icône des Listes modifiables : le curseur 

est un gros signe + ; avec un GlissG tracer un petit 
rectangle puis lâcher pour obtenir ceci 

• ClicD sur cet objet pour choisir dans le menu 
contextuel la commande Format de contrôle :la plage 
d’entrée est celle des noms des élèves ($B$2 :$B$8) et 
la cellule liée ($B$10) contiendra le numéro de l’élève (1 
à 7). Finir par OK. 

• Cliquer sur (6) de la liste pour choisir un élève : son numéro doit s’afficher dans la cellule B10.
Réciproquement, en tapant un numéro dans B10 on obtient le nom de l’enfant dans la liste déroulante. 

 
 b) Recopie automatique des notes d’un élève choisi : : 
• Dans la cellule C10 entrer la formule =recherche($B$10 ;$A$2 :$A$8 ;$B$2 :$B$8) : elle prend le numéro de 

l’élève dans la cellule B10, va chercher dans la plage B2 :B8 ce numéro, puis écrit dans C10 le nom de l’élève qui 
correspond à ce numéro. 

• Dans la cellule D10 entrer la formule =recherche($B$10 ;$A$2 :$A$8 ;C$2 :C$8) : on prend le numéro de 
l’élève dans B10, on le recherche dans A2 :A8 puis on met sa note au devoir D1 dans D10. 
 

• Faire quelques essais avec le choix d’un nom dans la liste déroulante, avec un numéro tapé dans B10. 
 

c) Utilisation d’une base de données : 
• Ouvrir le classeur DossierPLC1 > BASE.xls et se placer dans la feuille « Feuil2 » qui est vide. 
• Insérer une « Liste modifiable » comme ci-dessus 
• Aller dans  Format de contrôle par un ClicD pour saisir cela : (OK) 
• Dans A4 saisir 

=RECHERCHE($A$1;Feuil1!$A$2:$A$34;Feuil1!B$2:B$34) 
• Le nom apparaît dans A4 
• On prend dans A1 le numéro de la ligne de donnée qu’on recherche dans la zone $A$2 :$A$34 de la feuille 1 du 

classeur pour mettre dans A4 le nom (dans B$2 :B$34) qui correspond au numéro. 
• Propager la formule dans la même ligne 4 de A à F pour obtenir les autres données….(c’est pour cela que la 

formule n’est pas dollarisée devant la colonne B) 
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Sixième partie : Mises en forme – Validations des saisies 

 2)Mises en forme conditionnelle : 
 
 Permet de mettre dans une forme choisie une cellule dont le contenu remplit certaines conditions afin de le 

mettre en valeur.        Exemple :  
 
• Ouvrir dans DossierPLC1 le fichier 

BASE.xls et sélectionner la colonne 
de Notes (cliquer sur F) 

• Dans le menu Format cliquer sur Mise en forme conditionnelle et faire ces choix en cliquant ensuite sur 
Format pour la mise en forme des  12<Notes<15. 

• Sélectionner à présent la colonne Ville 
puis mettre MONTPELLIER en 
forme. 
 

• Cliquer sur Ajouter pour mettre 
NIMES en forme. 

Mettre en gras rouge les dates situées entre  
le 01/02/97 et le 30/05/97. 

1) La formule est : 
 
• Format > Mise en forme conditionnelle et 

choisir pour condition « La formule est » 
• On saisit la formule dans « Condition 1 » puis 

on choisit le Format du texte associé. 
• L’adresse est celle de la cellule active de la 

zone à laquelle s’appliquera la mise en forme conditionnelle... 
Formater la 2° plus grande valeur de la plage = A33= GRANDE.VALEUR($A$33:$I$33;2) 

22 45 58 79 102 99 23 64 

Formater des cellules de texte = ESTTEXTE(A23)  
Jean 145 01/05/2001 Pierre 12 Luc Bonjour 

Formater les chiffres pairs = MOD(A28;2)=0 
14 11 14 13 14 18 

Formater les cellules une sur deux = MOD(COLONNE();2) 
14 58 79 65 36 20 84 

Formater la valeur maximale d'une plage = A53 = MAX($A$53:$I$53) 
12 15 22 45 98 41 19 

Formater les valeurs dupliquées = SI(NB.SI($A$63:$I$63;A63)>1;VRAI;FAUX) 
14 19 14 58 49 23 58 98

Formater les valeurs supérieures à la moyenne  =A73>MOYENNE($A$73:$I$73) 
24 30 22 31 19 28 24 

Formater les cellules contenant une formule  =formulecell(A109) 
40 Pierre 875 15/06/2002 Samedi 5 Corse 

Formater les lignes paires (en jaune) et impaires (en vert) 
14   La formule est : = MOD(LIGNE();2)=0    
25   La formule est : = MOD(LIGNE();2)=1    
36        

    

Formater les week-ends = JOURSEM(A3;2)>5   
01/09/2001 02/09/2001 03/09/2001 04/09/2001 05/09/2001 06/09/2001 07/09/2001 08/09/2001
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4) Contrôle des saisies (validations) 
(Il s’agit d’entrer des nombres entiers entre 1 et 18 dans la zone A1 :B9) 
 

 Dans la feuille sélectionner la plage A1:B9  
 Aller dans le menu Données > Validation > onglet Options : sélectionner Entiers;1;18  
 Dans l'onglet Message de saise; entrer titre et message d'avertissement pour la saisie. 
 Dans l'onglet Alerte d'erreur;  entrer le titre et le message d'erreur. 

5)Vérifier que toutes les saisies sont différentes 
Il faut compléter les trois onglets :  
• onglet Options : cliquer sur le petit triangle de Autoriser pour aller choisir Personnalisé puis entrer la formule 

suivante. : ET(NB.SI($A$1:$B$9;A1)<2;A1>0;A1<19;A1=ENT(A1)) 
• EXPLICATIONS ! 
   - ET(Cond1;Cond2;Cond3;Cond4) : il faut que 4 conditions soient réunies 
pour autoriser la valeur entrée dans A1. 
   - NB.SI($A$1:$B$9;A1) donne le nombre d'apparitions de la valeur de A1 
dans la plage A2:C12 (les cellules doivent être  
     en bloc; $ pour que la plage reste fixe alors que A1 sera revalorisée). 
NB.SI()<2 pour éviter les doublons. 
   - A1<19 et A1>0 pour autoriser seulement les nombres entre 1 et 18. 
   - A1=ENT(A1) pour n'autoriser que les entiers (ENT(1,5)=1 donc différent de 
1,5)....Le plus dur est fait 
 

3)Quelques validations (contrôle des saisies) 
 

• Dans le menu Données > Validation >onglet des Option ; dans Autoriser  choisir Personnalisé 
• Sélectionner la plage future des saisies à contrôler (on accepte seulement les entrées indiquées) 
• Si les conditions ne sont pas remplies, une alerte est lancée…  
 

Accepter uniquement du texte Sélectionner la plage   
Jean   Pierre cinq dix  =ESTTEXTE(A5) 

Ne pas accepter les valeurs dupliquées     
 = NB.SI($A$11:$H$11;A11)=1  (Mettre un message d'erreur) 

14 18 22   jean   cinq 
N'accepter que des mots de 5 lettres commençant par A  
 = NB.SI(A17;"A????")=1     
Alain   arbre   amies aléas  
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Septième Partie : Compléments 
Le Publipostage (à partir d’un classeur Excel)-- Informations système 

1) Créer la base de données puis indiquer à Word votre source 
 

 Vous avez créé une liste d’adresse dans un classeur Excel avec des champs (NOM, Prénom..) dans la première 
ligne (Voir notre modèle DossierPLC1 > Base.xls. 

 
 Allez dans le menu Outils > Publipostage : 

 Cliquez sur Créer puis sur Etiquettes de publipostage dans le 
menu déroulant 

 Dans la boîte de dialogue, cliquez sur Fenêtre active.  
 
 

 De retour à la fenêtre de départ, cliquez sur Obtenir les données 
 Dans le menu qui se déroule, choisir Ouvrir la source de donnée 

 Sélectionnez alors   
en bas de la fenêtre de recherche puis DossierPLC1 > Base.xls 

 Validez tout par Ouvrir puis Activez les macros puis OK.  

2) Préparer la page d’étiquette 
 

 Dans la boîte de dialogue qui s’ouvre alors, cliquez sur le bouton : Préparer le document principal (la page des 
étiquettes).  

 
 S’ouvre alors cette nouvelle boîte de dialogue qui vous permet de 

sélectionner votre type d’étiquettes (dans la zone numéros de 
référence, on peut vérifier avec Détails) 

 Finir par OK 
 
 
 

 
 Cliquez sur Insérez le champ de fusion pour choisir l’un aorès l’autre les 

champs (NOM, Prénom…) et la mise en forme de vos étiquettes (mettre les 
espaces nécessaires et les retours à la ligne.) 

uez sur OK.  Lorsque le format d’étiquette est prêt, cliq
 Cliquez sur Fermer pour voir apparaître  

3) Fusionner la page d’étiquette avec les données  
 

 Il faut Enregistrer sous votre fichier sous le nom de votre 
choix. 

 Dans la barre d’outils,cliquez alors sur le bouton 

  pour achever le travail et voir vos étiquettes 
telles qu’elles seront imprimées. 
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Huitième partie : Filtres élaborés -Tableaux croisés dynamiques 
 1)Les filtres élaborés  (destinés à extraire des 

informations d’une base de données) : 
 
• On va ouvrir et utiliser une base de données 

fictive : BaseDonneesExemple.xls 
• On commence par nommer la zone 

(A1 :K285) de la feuille contenant la base : 
Insertion > Nom > Définir  

• On peut déjà travailler dans la même feuille 
que la base : 
o Entrer les critères (exemple ci-dessous) 

Dans M3 :N5 
 
o Entrer ensuite les champs que l’on désire dans la 

zone M7 :N7 
o Ainsi on aura les noms et salaires des femmes de plus de 60 ans 

et des hommes de moins de 20 ans 
• Aller dans le menu Données > Filtre > Filtre élaboré 
• Entrer les zones M3 :N5 et 

M7:N7 dans les fenêtres 
appropriées et finir par OK 

• Vous obtenez cette extraction de 
renseignements. 

sexe AGE en sept 98 

 femme >60 
homme <20 NOM SALAIRE 

sexe AGE en sept 98

femme >60 
homme <20 
  

NOM SALAIRE 

BIDAULT 11 483,70 F
DINIC 7 850,00 F
MARTIN 12 769,41 F
NAIMI 8 322,54 F

 Dans une autre feuille (on essaye de faire la même chose) 
• Insérer une nouvelle feuille dans laquelle on entre les critères (dans 

A1 :B3) et les champs requis dans A5 :B5. 
• Aller dans le menu Données > Filtre > Filtre élaboré  
• Dans la zone Plage de la boîte de dialogue 

entrer : »BaseDonneesExemple !base »  
• Compléter les autres zones puis OK….c’est fait 

 
Remarque : 
Si on ne précise pas les champs souhaités, alors on les obtiendra tous (il 
suffit de rentrer A5 dans « Copier dans » 



2)Les tableaux croisés dynamiques  (destinés à faire des synthèses des informations contenues dans la base) : 
 
• Ouvrir BaseDonneesExemple.xls et la 

feuille exo1 : il s’agit de reproduire le tableau 
qui existe dans cette feuille. 

 
• Ouvrir la barre d’outils : Affichage> Tableaux 

croisés dynamique 
 
• Cliquer sur la 3ème icône (Assistant) 

 
• Accepter les choix proposés et Suivant 

 
• Indiquer à la demande l’emplacement de votre 

base de données et Terminer . 
 
• Dans la feuille de calcul apparaissent des 

champs à compléter.  
 

• Capturer NOM dans les outils et lâcher le dans « Déposer Données » 
• Capturer SITE et déposer le dans la zone ligne (colonne de gauche) 

 
• Le premier exercice est terminé. 

 
 

• On peut déposer sexe dans la zone de champs (au-dessus)  
 
• Faire un clic droit sur le tableau et Mettre en forme le 

rapport pour choisir une mise en forme automatique. 
 
• Ici nous avons la répartition des femmes sur les 4 sites. 

 
• A noter qu’on peut sélectionner les catégories à afficher 

(voir ici à droite) 
 
• Double-cliquer sur le 12 de Strasbourg pour que s’affichent dans une nouvelle 

feuille les renseignements sur les 12 personnes concernées.. 
 
• Continuer les exercices (exos 2-3) proposés et découvrir les possibiltés 
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Changer la fonction somme :  (exo4) 
• Dans exo4 commencer par mettre le bouton Salaire dans 

la zone des données 2 fois de suite. 
• Sélectionner la cellule « Somme SALAIRE 2 » 
• Cliquer sur Paramètres de champ dans les 

outils  
• Choisir la fonction Moyenne pour remplacer 

somme des salaires par leur moyenne 
• Pour écrire autre chose que Moyenne SALAIRE 2, 

sélectionner la cellule et taper « Moyenne salaires » 
• Faire ensuite glisser le bouton SITES dans la colonne de 

gauche du tableau. 
• Intervertir les colonnes Données et SITE par un glisser-déplacer.. 
• Faire glisser le bouton Sexe vers la première ligne. pour finaliser. 

Grouper-Dégrouper (exo 5) 
• Commencer le tableau pour arriver à ce stade 
• Sélectionner les cellules(tranches 1-2-3) 
• Par un clic droit faire apparaître un menu et choisir 

Grouper 
• Remplacer Groupe 1 par « Les jeunes » 
• Continuer le travail. 

Trier le tableau (exo 11) 
• Commencer le tableau et mettre NOM dans les données puis TÉLÉPHONE par desus NB NOM 
• Double-cliquer sur TÉLÉPHONE, puis sur Avancé dans la boîte 

de dialogue 
• Choisir alors l’option de Tri par ordre décroissant sur les NB 

NOM (pour faire apparaître les répétitions) 
• Double-cliquer, dans la colonne de droite, sur les entiers différents 

de 1 : ces personnes ont le même numéro de téléphone… 
Pyramide des âges 
 

• Essayons de faire cela à partir d’un tableau croisé dynamique : 
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Neuvième partie : Formulaires 
1. Cases à cocher et boutons :   

Ouvrir la barre d'outils ci-contre dans le menu Affichage > Barre d'outils > Formulaires 
 a) Étiquette :  

 Cliquer sur Aa: le curseur de la souris devient (+), développer un rectangle par GlissG et 
lâcher l'étiquette.  

 Faire ClicD sur la bordure grise pour Modifier le texte. 

b) Bouton :  
 ClicG sur le bouton puis construire le bouton par GlissG (comme ci-

dessus).   
 Sélectionner le bouton puis ClicD sur la bordure grise. Choisir Modifier 

le texte pour le nommer à votre guise. 
 De la même façon aller choisir Format de contrôle pour choisir police et 

couleur...Utile pour déclencher une macro ( choisir Affecter une macro ). 

c) Case à cocher  
 ClicG sur la case à cocher et construire la case (même technique). 
 ClicD sur le pourtour et choisir Modifier le texte pour remplacer "Case..." par "J’ai compris". 
 Faire ClicG en dehors de l’objet pour voir le 

résultat, puis ClicD dessus pour ouvrir un 
menu : 

 Choisir alors Format de contrôle > onglet Contrôle et prendre par 
exemple $A$1 pour cellule liée. Cocher Ombrage 3D. 

 Après avoir cliqué sur OK, aller cocher et décocher la case pour observer l’effet dans la cellule A1. 

d) Case à option 
 Ouvrir une nouvelle feuille puis ClicG sur "case d'option" puis construire la 

case(même technique) 
 ClicD sur la case et choisir Modifier le texte pour écrire "PLC1" à la place de "Case…" 
 Choisir Format de contrôle puis $A$1 pour cellule liée dans l'onglet Contrôle et dans l'onglet Couleurs et 

polices, amusez-vous. 
 Construire 2 "Cases à option" supplémentaires que vous appellerez CAPLP2 et PE1 (pas 

besoin de contrôle, les 3 cases sont liées). Dans Format de contrôle > Couleurs et polices 
remettre le même format que la 1ère case (on peut aussi utiliser le balai         ) 

 Cocher successivement les trois cases à option et observer la cellule A1. Cela peut permettre de déclancher des 
actions avec des formules du style =SI($A$1=1;"Lycée-Collège";SI($A$1=2;"Lycée Professionnel";"Ecoles 
Primaires")). Testez !! 

 Taper 3 dans A1 puis 1 puis 0 : observer les résultats (après une saisie il faut prévoir de tout remettre à  0) 

e) Zone de groupe 
 MAIS si je veux construire de nouvelles cases à options, cet engin obtus va croire que c'est 

une 4ème option, erreur grave. 
 ClicG sur "Zone de groupe" puis entourer d'un cadre les 3 cases à option et lâcher le 

bouton gauche. 
 ClicD pour aller modifier le texte : mettre CONCOURS à la place de "Zone de groupe". 
 Construire 2 nouvelles cases à option et expérimenter : elles sont indépendantes des 3 autres. 



Maurice.Ocquidant@free.fr Section 9 _Page 2/2 09/09/2004 

2. Les compteurs : 
 ClicG sur "Barre de défilement" puis construire l'objet 

(GlissG) 
 ClicD sur l'objet puis ClicG sur Format de contrôle pour 

entrer ces choix 
 Finir Par OK puis tester le compteur ( 5 en 5 ici dans la case 

E15) 
 Même chose avec le compteur à côté (seul l'aspect change) 

3. Les listes déroulantes : (ouvrir un nouveau classeur   
 Dans la Feuil2, saisir dans les cellules A1 :A5 : PLC1-PLC2-CAPLP2-PE1-PE2.

Revenir dans la feuille Feuil1 
 Dans la barre Formulaires faire ClicG sur Zone de liste modifiable. 
 Construire l'objet avec GlissG puis faire ClicD sur l'objet pour ouvrir 

Format de contrôle. 
 Placer le point d'insertion dans "Plage d'entrée" puis retourner dans 

Feuil2 pour y sélectionner la plage A1-A5. 
 Revenir dans Feuil1 et la boîte : entrer $E$4 dans "Cellule liée" (toute cellule 

convient) et finir par OK. 
 Tester la liste : votre sélection affichera 1 à 5 dans la cellule E4 
 Information utilisable ensuite par des fonctions..        

 



Dixième partie : Sécurité - Protection 

1) Masquer le contenu de cellules (discrétion oblige) : 
 

 Dans la colonne des notes de Base.xls, sélectionner la colonne des notes (F) 
 ClicD dans cette plage et ouvrir Format de cellule et l'onglet Nombre. 
 Dans Catégorie choisir Personnalisé et dans Type taper trois points-virgule 

;;;  
 Finir par OK pour admirer le résultat (ou son absence). 
 Rétablir les choses en revenant dans la même boîte pour choisir une autre 

Catégorie que Personnalisé. 

2) Protection d’une zone de saisie :  
 

On peut protéger la colonne des notes seulement de saisies 
intempestives  

 Dans le classeur Base.xls sélectionner les colonnes A-B-C-D-E 
 ClicD dans cette plage et ouvrir Format de cellule et dans l'onglet Protection, décocher 
 Finir par OK puis aller dans le menu Outils > Protection > Protéger la feuille 
 Cocher tout et finir par OK. (Eviter de mettre un mot de passe pour l'instant) 

 Essayer d’entrer des notes, des dates puis aller dans Outils > Protection > Ôter la protection. 

3) Autorisation d’une zone de saisie dans une feuille 
 

 Sélectionner la zone de cellules (A1 :A20 par exemple) où la saisie restera autorisée. 
 Aller dans Format > Cellule > Onglet Protection pour enlever le verrouillage. 
 Aller ensuite protéger la feuille dans Outils > Protection > Protéger la feuille 
 Cocher les options et mettre un mot de passe. 
 Tester tout cela puis enlever la protection de la feuille. 

 
4 )Protection d’un document 
 

 Ouvrez essai.xls puis allez dans le menu Fichier > Enregistrez sous pour 
cliquer sur Outils 

 Choisissez alors Options générales puis entrez votre mot de passe dans la 
protection du document. 

 Finissez par Enregistrer sous le même nom 
essai.xls 

 Fermez votre document et tentez d’ouvrir à nouveau 
essai.xls, il faudra donner le mot de passe !! 

 En faisant la même procédure, allez supprimer ce 
mot de passe: 
Fichier > Enregistrer sous > Outils > Options générales 
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Partie Mathématiques : Compléments graphiques 

1) Courbe de régression  
 
 Ouvrez DossierPLC1 > exerc.xls et la feuille exo4. Sélectionnez A1:L2.  
 Choisir Ce type de nuage de points :  
 Faire ClicD sur un point du nuage puis : 

 

2) Tracer plusieurs courbes sur un même graphique 
 Mettre x  en A1 puis sélectionner la colonne A et dans le menu 
Insertion>Nom>Créer , choisir Ligne du haut 

 Mettre -2 et -1,8 dans A2 :A3 puis copier vers le bas(…2,6 ; 2,8 ; 3). Saisir 
=exp(x) dans B2 et propager. 

 Tracer avec  une première courbe (Nuages de points) avec ce type de 
nuage.(ici y=exp(x) : on sélectionne la plage A2 :B27) 

 Dans C2 saisir =x^2 et propager dans 
C2 :C27. 

 Sélectionner le graphique et lancer l’assistant 

 puis Ajouter une série à l’étape 2 et 
choisir ces valeurs. 

3) Animer ce graphique 
MÉTHODE 1 : (AVEC UN COMPTEUR) 

 Construire avec Barre d’outils > Formulaires un compteur 
 ClicD dessus et choisir dans Format de contrôle du menu Min=0 ; Max =5 et Cellule liée=D1 
 Dans D2 mettre =(D1-2)/10 (défilement de pas 0.1 de -2 à 3) 

 Dans D3 mettre =exp(D2)….pour finir par construire une Série3 avec  
 Finir par mettre en forme ce point isolé pour le voir mieux…Tester avec le compteur. 

 
MÉTHODE 2 :  (AVEC UNE MACRO) 

 Passer dans VBEditor (Alt F11) puis Insertion > Module  
et taper ce code : 

 Revenir dans le classeur (Alt + Q)  
 Insérer une « forme automatique »  
 Faire ClicD dessus pour y mettre un titre et lui  
Affecter une macro  (TracePoint) 

 Cliquer sur ce bouton pour tester. 
 

4) Transformer un graphique en image 
 

 Sélectionner le graphique et le Couper. 
 Aller dans Edition pour faire un Collage spécial. 
 On a une image au format *.wmf. 

TracePoint
Sub TracePoint() 
débutN = -2 
finN = 3 
pasN = 0.01 
Range("d5").Select 
Range("D5").Value = débutN 
For i = débutN To finN Step pasN 
Cells(5, 4).Formula = i 
Range("a3").Select 
Next i 
End Sub
e 1/2 09/09/2004 



5) Tracés de surfaces planes dans l’espace 
 

  Il est possible de tracer très facilement des surfaces avec Excel, voici quelques exemples tirés des programmes 
de 1ère ES et Ter ES. 

  Ainsi on veut représenter le paraboloïde de révolution 
d’équation z =x² + y²   

 
 Mettre –5, -4, …,4, 5 dans la plage A2 :A12 
 Mettre –5, -4, …,4, 5 dans la plage B1 :L1 
 Dans B2 saisir la formule : =$A^2+B$1^2 et transmettre à B2 :B12 puis à toute la plage B2 :L12 

 Sélectionner la zone A1 :L12 puis  et choisir les options  et  
 Aussitôt vous obtenez la surface désirée. 
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 On peut obtenir une projection dans le plan (xOy) avec la même sélection : il suffit d’opter 
pour ce type de représentation. 

 Représenter les surfaces dont les équations sont : 
 z=(-x²-y²+6x+8y)/5 avec x∈[0 ;8] et y ∈[0 ;10] 
 le plan d’équation z=10-x-y et x∈[0 ;10] et y ∈[0 ;10] 
 le cône d’équation z=rac(x²+y²) et x∈[-5 ;5] et y ∈[-5 ;5] 
 z=5/(1+x²+y²) et x∈[-5 ;5] et y ∈[-5 ;5] 

 -5 -4 
-5 =$A2^2+B$1^2 =$A2^2+C$1^2 
-4 =$A3^2+B$1^2 =$A3^2+C$1^2 

6) Faire tourner ces surfaces avec des macros 
 

 Passer dans VBEditor (Alt F11) puis Insertion > Module  
et taper ce code : 

 Revenir dans le classeur (Alt + Q)  
 Insérer une « forme automatique »   
 Faire ClicD dessus pour y mettre un titre et lui  
Affecter une macro  (rot2) 

 Cliquer sur ce bouton pour tester.(on tourne de 5° 
autour d’un axe vertical. 

 
 Il suffit de faire 4 macros (presque) identiques  
 Pour faire une rotation d’axe horizontal (remplacer 
Rotation par Elevation dans le code) 

 Aller voir l’effet dans DossierPLC1 > Espace 
 

Sub rot2() 
    ActiveSheet.ChartObjects("Graphique 
1").Activate 
    ActiveChart.Corners.Select 
    x = ActiveChart.Rotation 
    If x > 5 Then 
    x = x - 5 
    With ActiveChart 
        .Rotation = x 
    End With 
    Else 
    x = 359 
    With ActiveChart 
    .Rotation = x 
    End With 
    End If 
End Sub 
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Partie Mathématiques : Animations graphiques avec Macros 

1) Animation d’un tracé à l’aide d’une macro 
(Il faudra l’adapter pour chaque fonction) 
 
TRACÉ DE LA COURBE :   

 Remplir les colonnes ABCD sur 128 lignes      

 Sélectionner la zone B1 :C128 pour tracer une première fonction avec  (option Nuage de points) 
 Changer les plages des axes (ClicD sur les axes puis Modifier les axes et onglet Echelle 
  

MACRO D’ANIMATION : 
 On supposera que l’utilisateur est déjà familiarisé  
avec VBEditor. (Alt+F11) 

 Insertion > Module…saisir le code de la macro 
 

 Revenir dans Excel (Alt + Q) 
 

 Construire un bouton pour lui affecter la macro 
qui se nomme TraceCourbe 

 
 Tester cela… 

2) Des objets qui tournent (les objets recoivent un numéro 1-2-3…dans l’ordre de création) 
 

 Construire un objet « Forme automatique » à l’aide de la barre de dessin  
 Aller dans VBEditor (Alt+F11) pour entrer le code de la macro 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Revenir dans Excel (Alt+Q) et ClicD sur l’objet pour Affecter la macro « Tourne ».  Tester 
 

For i = 128 To 1 Step -1 
Cells(i, 2).Formula = 0 
Range("B1").Select 
Next i 
 
x = -0.05 
For i = 1 To 128 
x = x + 0.05 
Cells(i, 2).Formula = x 
Range("B1").Select 
Next i 
End Sub 

Sub TraceCourbe() 
Range("B1:B64").Select 
For i = 128 To 1 Step -1 
Cells(i, 2).Formula = 0 
Range("B1").Select 
Next i 
x = -0.05 
For i = 1 To 128 
x = x + 0.05 
Cells(i, 2).Formula = x 
Range("B1").Select 
Next i 
x = 6.3 

Sub Tourne() 
Sheets("Feuil3").Activate 
Randomize 
Dim s As Long 
For i = 1 To 100     
Worksheets("Feuil3").Shapes.Range(Array(2)).Select   ‘ Sélection de l’objet 
Selection.ShapeRange.IncrementLeft 1  ‘Vers la droite 
Selection.ShapeRange.IncrementTop 1   ‘Vers le bas 
Selection.ShapeRange.Fill.ForeColor.RGB = RGB(256 * Rnd, 256 * Rnd, 256 * Rnd)  ‘Couleur aléatoire 
Selection.ShapeRange.IncrementRotation 2   ‘Rotation de l’objet 
Range("A1").Select 
Next i 
For i = 1 To 100    ‘Même chose à l’envers pour revenir au point de départ 
Worksheets("Feuil3").Shapes.Range(Array(2)).Select 
Selection.ShapeRange.IncrementLeft -1 
Selection.ShapeRange.IncrementTop -1 
Selection.ShapeRange.IncrementRotation -1 
Selection.ShapeRange.Fill.ForeColor.RGB = RGB(256 * Rnd, 256 * Rnd, 256 * Rnd) 
Range("A1").Select 
Next i 
End Sub 
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3) Tracé d’une courbe  (à choisir dans une liste et avec une animation) 
LA FEUILLE DE CALCUL 

 Il est simplement question, sur un intervalle unique [-3 ; 3] et sur quelques fonctions de référence, d’avoir 
une approche un peu pédagogique de la notion de coordonnées. 

 Ce sera aussi l’occasion de découvrir quelques contrôles ActiveX intéressants  
 Il est possible d’ajouter des fonctions dans les cellules A1 :A50 (pas de signe = devant et respecter la 
syntaxe des fonctions utilisées par Excel) 

 Le graphique est fait de 2 séries : l’une dans la plage AX3 :AY123 pour tracer la courbe représentative de la 
fonction sélectionnée et l’autre dans .AX2 :AY2 pour le point qui se déplace (cellules alimentées par macro)

 Pour les abscisses : dans la feuille de calcul écrire x en AX1 puis sélectionner la plage AX1 :AX123. 
 Dans le menu Insertion > Nom > Créer il faut cocher Ligne du haut (la variable x est attribuée aux 
cellules) 

 Mettre les abscisses dans AX3 :AX123 : -3 ;-2.95……2.95 ; 3. 
 Pour les ordonnées : une macro va recopier =f(x) dans les cellules correspondantes de la colonne AY mais le 

calcul sera effectué automatiquement (ainsi il y a 1 dans AX83, nous aurons la valeur f(1) dans AY83).   
 
LES CONTRÔLES (4 au total) 

 Dans le menu Affichage>Barre d’outils  ouvrir Boîte à outils 
Contrôles 

 Pour entrer les fonctions : construire une Combobox1    et cliquer sur  pour accéder à ses propriétés : 
mettre A1 :A50 dans ListFillRange. 

 Désactiver le mode Création  pour venir 
saisir quelques fonctions Dans A1 :A50 (2*x-3 ; sin(x) ; exp(-x^2) ;…) 

 Vérifier que ces fonctions apparaissent bien dans la Combobox. 

 Créer le ScrollBar1  (compteur) et 2 TextBox  (pour afficher x et y) 
 Dans les propriétés du ScollBar1, choisir 121 pour Max. 

 
LES MACROS 

 Double-cliquer sur ComboBox1 pour entrer dans VBEditor 
 Elle sera donc « alimentée par les cellules A1 :A50 » 

Private Sub ComboBox1_Change() 
Dim f As String 
f = "=" & ComboBox1.Value ‘On met dans f (variable String) la definition de f (avec = devant) 
Range("AY2:AY123").Value = f  
End Sub 

 Revenir dans Excel puis double-cliquer sur ScrollBar1 pour entrer ce code 
Private Sub ScrollBar1_Change() 
Dim a As Single, b As Single, k As Single 
k = ScrollBar1.Value  ‘On attribue à k la valeur entière du ScollBar   (entre 0 et 121) 
a = -3.05 + k * 0.05  ‘Valeur de l’abscisse x  entre –3 et 3 (pas 0.05) 

   f = "=" & ComboBox1.Value ‘On met dans f (variable String) la definition de f (avec = devant) 
Range("AY2:AY123").Value = f ‘Cette definition est attribuée à la plage des ordonnées 
Range("AX2").Value = a  ‘On met l’abscisse du point mobile dans AX2 (l’ordonnée est calculée     
 ‘automatiquement dans AY2) 
b = Range("AY2").Value  ‘b prend pour valeur l’ordonnée du point mobile 
TextBox1.Value = "x=" & a ‘On affiche dans les 2 TextBox les coordonnées du point mobile. 
TextBox2.Value = "y=" & b 
End Sub 

Le GRAPHIQUE 
 Construire le graphique avec l’assistant graphique et choisir le type «Nuage de points » et courbe avec 
lissage puis sélectionner la plage des valeurs AX3 :AY123 

 Construire une nouvelle série d’un seul point AX2 :AY2 (faire les mises en forme nécessaires) 
 Construire les traits de rappel avec 2 nouvelles séries. 
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4) Un titre qui bouge aléatoirement 
 

 Faire un titre WordArt (lancer avec ) dans la feuille. 
 Aller dans  VBEditor pour saisir la macro ci-dessous. 

 
Sub rotitre() 
Sheets("Feuil4").Activate 
Randomize 
For i = 1 To 100 
Worksheets("Feuil4").Shapes.Range(Array(1)).Select    ‘Sélection de l’objet 
x = Int(1 + 10 * Rnd)   ‘Affectation aléatoire de x 
If Rnd < 0.5 Then 
x = -x 
End If 
y = Int(1 + 10 * Rnd) 
If Rnd < 0.5 Then 
y = -y 
End If 
z = z + 5    ‘Incrémentation de z 
If z > 359 Then 
z = -360 
End If 
Selection.ShapeRange.ThreeD.IncrementRotationX x     ‘Rotation de x dans un axe de l’écran 
Selection.ShapeRange.ThreeD.IncrementRotationY y 
Selection.ShapeRange.IncrementRotation z                   ‘Rotation suivant un axe perpendiculaire à l’écran 
    Selection.ShapeRange.Fill.ForeColor.SchemeColor = Int(57 * Rnd)  ‘Couleur aléatoire 
    Selection.ShapeRange.Fill.BackColor.SchemeColor = Int(57 * Rnd) 
    Selection.ShapeRange.Fill.TwoColorGradient msoGradientDiagonalUp, 4 
    Selection.ShapeRange.ThreeD.Depth = Int(100 * Rnd)               ‘Profondeur aléatoire du profil 
    Selection.ShapeRange.ThreeD.ExtrusionColor.SchemeColor = Int(57 * Rnd)  ‘Couleur aléatoire du profil 
Range("A1").Select 
Next i 
End Sub 

 Revenir dans Excel pour Associer la macro au titre WordArt. 



Partie mathématiques : Valeur cible et solveur 

1) Valeur Cible : 
 

 Il est question de trouver l’antécédent d’une valeur par une fonction donnée. 

 Entrer x dans A1, sélectionner A1 :A2 puis Insertion > Nom > Créer 
Exemple1 :  

 Entrer dans B3 (par exemple) la fonction (=2*x-1 ici) 
 Sélectionner B3 puis aller dans Outils > Valeur Cible  
 Compléter ainsi les rubriques et OK….2,5 apparaît dans A2 
 Nous avons résolu l’équation 2*x-1=4 ! 

Exemple2 : 
 Entrer dans B3 la fonction =x^2-3*x 
 Sélectionner B3 puis Outils > Valeur Cible et chercher l’antécédent de –1 à mettre dans A2 
 Si au départ il y a 0 dans A2, on aura la solution 0,5 approchée  
 Mais si on met 2 dans A2, on obtiendra la solution 1 dans A2 (je pense qu’on utilise la méthode de Newton 

initialisée par le contenu de A2 pour trouver une valeur approchée des solutions). 
2) Installer le solveur : 

 
 Aller dans Outils > Macros complémentaires  
 Cocher « Solveur » et valider. 
 Si l’installation de Office a été celle par défaut 

alors le CD d’Office sera demandé. 

3) Premier exemple (résolution de x^2=3) 
 

 Entrer x dans A1, sélectionner A1 :A2 puis Insertion > Nom > Créer. 
 Entrer la formule =x^2 dans B2 
 Sélectionner B2 puis aller dans Outils > Solveur pour ouvrir cette boîte qui va nous permettre de résoudre 

l’équation x^2=3 (une solution dans A2) 
 Il suffira de changer la valeur initiale dans A2 (par exemple –2) pour obtenir l’autre solution. 

4) Deuxième exemple : (résolution du système : 2x-3y=4 et 6x+y=2) 
 

 Entrer x dans A1, y dans B1, sélectionner A1 : B2 et Insertion > 
Nom > Créer. 

 Entrer les formules : =2*x-3*y dans C3 et =6*x+y dans C4 
 Sélectionner C3 puis Outils > Solveur et compléter les 

rubriques ainsi :  
 $C$3=4 et la contrainte $C$4=2 sont les 

deux équations dont les solutions seront 
mises dans A2 et B2 après avoir cliqué sur 
Résoudre. 

Applications :   
 Résoudre un système linéaire de 3 

équations à 3 inconnues. 
 Résoudre le système   4x^2+9y^2=36 et 

y=  2x-4) 
 Cocher  Réponses dans Rapports 
 Aller voir ce rapport dans la feuille engendrée qui se nomme : Rapport des réponses. 
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Partie Mathématiques  :  Fonctions 

1) Fonctions mathématiques 
 

=ABS(x) : renvoie la valeur absolue de x 
=ALEA() : renvoie un nombre aléatoire de [0 , 1[ 
=ALEA.ENTRE.BORNES(a ; b) : renvoie un nombre aléatoire entier de [a ; b[ 
=ARRONDI(x ;n) : arrondit x au nombre n de chiffres 
=COMBIN(n ;p) : nombre des combinaisons p à p de n éléments 
=DEGRES(x) : convertit x radians en degrés décimaux (ainsi =DEGRES(PI()/5) donne 36°) 
=ENTx) : retourne la partie entière de x   (=ENT(-2,5) donnera –3) 
=FACT(n) : retourne n !   et =FACTDOUBLE(n) renvoie n !! 
=LN(x) : donne le logarithme népérien   et =LOG10(x) donnera le logarithme décimal 
=LOG(x ;a) donnera le logarithme de x en base a. 
=MOD(n ;p) : renvoie le reste de la division de n par p (=MOD(28 ;5) donne 3) 
=PGCD(a ;b ;c ;d….) : donne le PGCD de a,b,c,d…et =PPCM(a ;b ;c ;d….) donne le PPCM 
mais dans la boîte de dialogue) 
=PUISSANCE(x ;n) : renvoie x à la puissance n    
=QUOTIENT(n ;p) : donne la partie entière dans une division euclidienne 
=RACINE(x) : évident 
=RADIANS(x) : transforme les degrés décimaux en radians 
=ROMAIN(n) : transforme un entier en chiffres romains. 

2) Calculs matriciels 
 
=DETERMAT(matrice) : renvoie le déterminant de la matrice (=DETERMAT({2.3 ;4.5}) donne –2) 
=INVERSEMAT(matrice) renvoie la matrice inverse  (Résultat dans la boîte de dialogue seulement) 
=PRODUITMAT(matrice1 ;matrice2) : calcule le produit de 2 matrices 
 (=PRODUITMAT({2.3;4.5};{6.7;8.9}) donne {36.41 ;64.73} 
 
Méthode :  (validation par Ctr+ MAJ +Entrée) 

 Entrer la matrice comme ci-contre puis sélectionner une cellule vide. 

 Activer l’outil fonction  sur DETERMAT et entrer la plage A1 :D3 dans la 
rubrique Matrice 

 Valider par Ctrl + MAJ + Entrée au lieu du bouton de commande OK. 
 Pour le produit : entrer les 2 matrices(ex. :3x3 ) dans des 

cellules. 
 Sélectionner une plage vide 3x3 qui recevra le résultat 
 Lancer l’outil fonction sur PRODUITMAT puis entrer 

A1 :C3 dans la rubrique Matice1 et E1 :G3 dans Matrice2. 
 Valider par Ctrl + MAJ + Entrée. 

3) Fonctions statistiques (les plus courantes) 
 

=COEFFICIENT.CORRELATION(plage1 ;plage2) : renvoie le coefficient de corrélation de 2 séries se  
          trouvant dans plage1 et plage2 
=COVARIANCE(plage1 ;plage2) : covariance de 2 séries statistiques 
=DROITEREG(plage1 ;plage2) : il faut sélectionner une plage de 2 cellules (pour a et b) puis lancer la   
 fonction et saisir les plages dans Y_connus et X_connus. Finir par Ctr+ MAJ +Entrée 
=ECARTYPEP(Plage) : donne l’écart-type d’une population alors que ECARTYPE(Plage) se base sur un  
    échantillon de 30 valeurs. 
 



=FREQUENCE(Plagedonnées ;PlageIntervalles) : C’est une magnifique fonction qui 
donne les fréquences d’apparition dans les plages précisées. 

 On entre les limites des intervalles (ici [1 ;10[ ; [11 ;20[….) 
 On sélectionne la plage qui correspond aux fréquences dans ces intervalles. 
 On lance la fonction FREQUENCE et on met dans Tableau_données la plage 

des données (ici A1 :A143) et dans Matrice_intervalles la plage des limites des 
intervalles (ici B1 :B5) 

 Finir par Ctr+ MAJ +Entrée (surtout pas OK) 
=LOI.BINOMIALE(NombreSuccès ;NombreTirages ; ProbaSuccès ;vrai-faux)

 Les entrées sont claires : ici on calcule la probabilité de 3 succès exactement sur 
10 tirages (p(succès)=1/6) et si on met « FAUX » dans Cumulative. 

 Si on met « VRAI » dans Cumulative on calcule la probabilité de 3 succès au plus 
(c’est une distribution). 

 
=PERMUTATION(n ;p) : nombre des arrangements de n objets p à p 
=RANG(nombre ;plage) :détermine le rang d’un nombre dans une plage (par exemple si vous avez des notes  
  dans une plage D3 :D40, =NB.SI(D3 ;$D$3 :$D$40) donnera le rang de l’élève) 
 

4) Fonctions de comptage de cellules  (dans la catégorie statistiques) 
 
=NB(Plage) : compte les cellules contenant des nombres dans une plage de cellules (ignore le texte et le vide) 
=NBVAL(Plage) : compte les cellules occupées dans une plage (par des nombres ou du texte) 
=NBVIDE(Plage) : compte les cellules vides dans une plage 
=NB.SI(Plage ; critère) : compte les cellules d’une plage qui satisfont à un critère (ainsi =NB.SI(A1 :D12 ;2)  
    va compter le nombre de « 2 » dans la plage A1 :D12) 

5) Traitement des mots : quelques exemples   
Comment afficher la première lettre d'un mot en majuscule  
jean Jean  = NOMPROPRE(A42) 
Comment afficher le mot complet en majuscule   
dimanche DIMANCHE = MAJUSCULE(A48) 
Comment regrouper le contenu de plusieurs cellules en une seule cellule 
Jean Pierre Costa Jean Pierre Costa  =A53&" "&B53 &" "&D53 
Extraire les éléments d'une cellule  =GAUCHE(A8;CHERCHE(" ";A8)-1)   
Pierre Michel   Pierre Michel  =DROITE(A8;NBCAR(A8)-TROUVE(" ";A8)) 

Comment récupérer la partie décimale d'une valeur  
158,568 14,35 125,36 0,78 125,7896 236,214  

568 35 36 78 7896 214  
 =SI(ESTERREUR(TROUVE(",";A92;1));"";DROITE(A92;NBCAR(A92)-TROUVE(",";A92;1)))  

6) Somme indirecte 
 

 Dans la colonne A insérer des nombres (1-2-3….) : on souhaite faire les sommes A1 :Ai (i variable) 
 Construire un compteur (avec l’outil Formulaires), la valeur de ce compteur étant dans B3 
 Dans D3 mettre la formule   =SOMME(INDIRECT(« A1 :A » & B3))  la plage sommée variera avec le 
compteur. 

1    
2    

3 15
 
  120

4     
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Partie Mathématiques : Statistiques-Simulations 

1) Lancer une pièce : 
 Sélectionner la plage A1 :J10 ( ou A1 :J1000) puis Insertion > Nom > Définir 
 Donner un nom à la plage (Plage100  ici) puis OK. 
 (Si la plage est grande entrer la référence à la main =Feuil1 !$A$1 :$J$1000 puis 

cliquer sur Ajouter) 

   Sélectionner la plage (dans la liste en haut à gauche) 
 Saisir alors =SI(alea()<0,5 ;0 ;1) et valider par Crtl + Maj + Entrée 
 Pour compter les occurrences de 0, entrer =NB.SI(Plage100 ;0) 
 Il suffit ensuite de cliquer sur F9 pour renouveler les 100 essais… 

 Autre idée :  Mettre 0 et 1 dans A13 :A14 puis sélectionner B13 :B14 
 Entrer ensuite la formule ci-dessus et finir par Ctrl + Maj + Entrée 

2) Lancer un dé -  Échantillonnage : 
 Insertion > Nom > Définir  Population ($A$1 :$J$1000)   Définition de la plage Population 

 Cliquer sur Population puis saisir =ent(1+6*alea()) et valider par Ctrl 
+ Maj + Entrée 

 Après une attente assez longue les fréquences s’affichent. 
 Définir la plage Echantillon dans $A$1 :$J$10 (100 jets) 
 Sélectionner M1 :M6 pour entrer la formule : 

=nb.si(Echantillon ;K1 :K6) et valider par  Ctrl + Maj + Entrée 
pour avoir les fréquences de l’échantillon 

 Multiplier les essais avec F9. 

Utilitaire d’analyse  
3) Activer cet utilitaire 
Aller d’abord dans le menu Outils > Macros complémentaires pour vérifier que Utilitaire d’analyse est coché, 
sinon il faut le faire puis valider par OK. 
 
4) Génération de nombres aléatoires (1000 jets d’un dé pipé, on connaît la loi de probabilité) 

 Mettre 1-2..6 dans A1 :A6 et 0.082 ; 0.12 ; 0.153 ;0.207 ; 0.265 ; 0.173 dans B1 :B6 (dans Classeur1) 
 Ouvrir Outils > Utilitaire d’analyse > Génération de nombres aléatoires 



5) Histogramme-Statistiques Descriptives 
 Dans la feuille précédente : Outils > Options > Statistiques Descriptives et compléter 
 On obtient les paramètres de la colonne1 avec (plage d’entrée=D1 :D1000 ; plage de sortie=F10 et en 

cochant Rapport détaillé et niveau de confiance. 
 Pour obtenir l’histogramme : Outils > Options > Histogramme 

 

 
 
6) Loi binomiale  

 Il est question (par exemple) de faire une simulation de 100 séries de 1000 lancers d’une L-pièce 
 Dans une feuille vierge Outils > Utilitaire d’analyse > Génération de nombres aléatoires : les 100 
échantillons de 1000 jets sont dans la colonneA 

 Par la suite on lancera Statistiques descriptives (voir ci-dessus) 
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Partie Mathématiques : Quelques fiches d’activités 
1) Fiche sondage 

 
 Définir une plage 50x20 "plage1000" par  Insertion>Nom>Définir : $A$3:$AX$22   
 Sélectionner la feuille (Ctrl+A) et faire un ClicD sur les en-têtes de colonnes : dans le menu choisir 
"Largeur" et adopter 2. 

 Barre de défilement : ouvrir Affichage > Barre d'outils> Formulaire et activer l'outil "Barre de 
défilement". 

 Construire cette barre avec le bouton gauche enfoncé.     
 * Faire un clicD sur cet objet et activer "Formats de contrôles" et choisir : min=0; Max=100; cellule 
liée=A2   puis la cellule F2=A2/100 

 Sélectionner "plage1000" et saisir dans la cellule active A3 =SI(ALEA()<$F$2;"N";"O")     
 Valider par les 3 touches Ctrl+Maj+entrée 
 Mise en forme :  dans Format > Mise en forme conditionnelle : si la valeur de la cellule est égale à 
="N" alors Format (à choisir). 

 Condition2 : si la valeur de la cellule est égale à ="O" alors Format (à choisir). 
 Après validation de tout cela, sélectionner "plage1000" puis ClicDroit sur cette zone et choisir 
Format de cellule 

 Dans l'onglet Nombre choisir Personnalisée et mettre ;;; dans la zonr de saisie  (pour faire 
disparaître les caractères) 

 * Effectifs   : Dans U2 saisir =NB.SI(plage1000;"N") et dans U3 =NB.SI(plage1000;"O") 
Echantillonnages (par 100) 
 
* Avec remise : Mettre dans A26 =INDEX(plage1000;ENT(1+20*ALEA());ENT(1+50*ALEA()))  
transmettre à la plage A26:J35 
* Dans Z2 saisir =NB.SI(A26:J35;"N") et dans Z3=NB.SI(A26:J35;"O") 
* Sans remise : Recopier une plage 10x10 (A3:J12 par exemple) vers la plage  P26:Y35. 

 



2) Fiche "lancer d'un dé" 
 

 Numéroter la colonne A de 1 à 2000 : Insertion > Nom > Définir  "plageA"  qui sera $A$1:$A$2000 
pour 2000 jets 

 Sélectionner cette plage et saisir =LIGNE() pour valider par Ctrl+Maj+Entrée 
 Lancer 2000 fois le dé : saisir dans B1=ENT(1+6*ALEA()) et transmettre par un double-clic sur 
le petit carré noir. 

 Pour avoir une fréquence relative des "6" : C1=NB.SI($B$1:B1;6)/A1 puis transmettre par 
double-clic. 

 Faire le graphique : Commencer par Insertion > Nom >Définir pour nommer la plage 
"Fréquences" de $C$1:$C$2000 

 Sélectionner cette plage puis avec l'assistant graphique tracer votre graphique (option Nuage de 
points) 

 Tracer la droite d'équation y=1/6 (mettre d'abord les coordonnées  (0,1/6) et (2000,1/6) de 2 
points dans M34:N35) 

 Sélectionner votre graphique puis avec l'assistant graphique à l'étape 2, ajouter une série. 
 Pour ajouter le série : sélectionner 0 et 2000 pour x puis 1/6 et 1/6 pour y. 
 Statistiques : Mettre 1 à 6 dans F15 :F20  
 * Sélectionner la plage G15:G20 et saisir =NB.SI(B1:B2000;F15:F20) pour valider avec  
Ctrl+Maj+Entrée 
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3)  Fiche "10 000 lancers d'un dé avec échantillonnages" 
 
Création de la population :  

 Insertion>Nom>Définir une plage "Population" dans $A$2:$T$501 (20x500) 
 Sélectionner la feuille (Ctrl+A) puis ClicD sur les têtes de colonne pour choisir Largeur=3 
 Sélectionner la plage Population et entrer =ENT(1+6*ALEA())....Valider par Ctrl+Maj+Entrée. 
 Pour "fixer" la population : sélectionner la plage et faire un Copier 
 Edition > Collage Spécial > Valeurs  ainsi la population ne sera plus recalculée à chaque 
mouvement. 

 
Echantillonnages : 

 * Sans répétition :Sélectionner A1 puis  Insertion > Nom > Définir   la plage "Echantillon" mais en 
relatif  A1:J10 (pas de $) 

 Sélectionner au hasard une cellule (D12 par exemple) puis sélectionner la plage "Echantillon" : la 
plage D12:M21 est alors sélectionnée 

 Capturer et recopier cette plage (avec souris et touche contrôle enfoncée) vers X10:AG19. Vous 
avez un échantillon. 

 Avec répétition : Saisir dans X22 =INDEX(Population;ENT(2+500*ALEA());ENT(1+20*ALEA())) 
 Transmettre à la plage X22:AG31 ...On obtient ainsi un 100-échantillon de la population. 

 
Statistiques 

 Mettre 1, 2...6 dans V2:V7 puis sélectionner W2:W7 pour entrer =NB.SI(population;V2:V7) et 
valider par Ctrl+Maj+Entrée 

 Sélectionner W12:W17 et entrer =NB.SI(Echantillon;V2:V7) pour le premier échantillon (valider 
par Ctrl+Maj+Entrée) 

 * Sélectionner W25:W30 et entrer =NB.SI(X22:AG31;V2:V7) pour le 2ème échantillon et valider 
par Ctrl+Maj+Entrée. 
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4)  Fiche pluie aléatoire 
 
Les calculs 

 * Nommer "pluie" une plage A1:B1000 (avec Insertion > Nom > Définir)       * Sélectionner cette 
plage  

 Saisir la formule =ALEA() pour finir par les 3 touches : Ctrl+Maj+Entrée  (on a ainsi saisi la 
formule dans toute la plage) 

 C1=SI(RACINE(A1^2+B1^2<1;1;0) et transmettre à C1:C1000 (on teste si le point de coordonnées 
(Ai,Bi) est dans le quart de disque) 

 * D1=SOMME($C$1:C1)/LIGNE() et transmettre à D1:D1000 (on calcule la fréquence relative des 
points dans le quart de disque) 

Les graphiques 
 Dessiner un arc de cercle : dans K1:K50 incrémenter 0; 0,02; 0,04; 0,06; …..0,98; 1 et dans L1 =RACINE(1-
K1^2) et transmettre dans L1:L50 

 Tracer le quart de cercle (avec l'option graphique "Nuage de points") 
 Dessiner les gouttes de pluie : sélectionner le graphique précédent,  cliquer sur l'assistant graphique. 
 * Aller tout de suite à l'étape 2 pour définir votre nouvelle série (A1:A1000 pour x et B1:B1000 pour y) 

 

5)  Fiche lancers de 2 dés 
 

 La ligne 1 est réservée aux titres. 
 Insertion>Nom>Définir les  2 plages "déA" dans A2:A2001 et "déB" dans B2:B2001 
 Sélectionner ces 2 plages (avec la touche contrôle enfoncée) et saisir =ENT(1+6*ALEA()) puis 
valider par Ctrl+Maj+Entrée 

 Définir une plage "Somme" dans C2:C2001 et sélectionner cette plage Somme 
 Saisir alors la formule  =déA+déB et valider par Ctrl+Maj+Entrée 
 Les statistiques : Mettre 2, 3,..12 dans la zone D2:D12 
 Sélectionner la plage E2:E12 pour saisir =NB.SI(Somme,D2:D12) et valider par Ctrl+Maj+Entrée 
 Histogramme : Sélectionner la plage D2:E12 et choisir l'option Histogramme 
 * Faire apparaître dans O2:O12 les probabilités pour les faire apparaître dans le même 
graphique. 
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6) Comment faire des images d’une feuille de classeur ? ?  
Méthode 1 (générale dans Office) 

 Sélectionner le graphique et le Couper. 
 Aller dans Edition pour faire un Collage spécial. 
 On a une image morte au format *.wmf. 

 
Méthode 2  (une macro pour une image au format JPG) 

 Dans Excel se mettre dans le VBEditor (Alt+F11) 
 Dans le menu Fichier > Importer  choisir dans DossierPLC1 > Macros le fichier exportgif.bas 
 Revenus dans le classeur excel (Alt+Q) il suffit de lancer la macro exportgif 

Sub exportgif() 
Dim Plage As Range 
Set Plage = Application.InputBox(Prompt:="Sélectionner votre zone: (Ex. A1:B10) ", _ 
Title:="Sélection de zone ", Default:="$A$1", Type:=8)  ‘Appel de la zone de la feuille à transformer en image 
Application.ScreenUpdating = False 
Workbooks.Add 
Plage.CopyPicture 
ActiveSheet.Paste 
With ActiveSheet.ChartObjects.Add(0, 0, _ 
Selection.Width, Selection.Height).Chart 
.Paste 
.Export "F:\fiches_excel\nom.gif", "GIF"  ‘Chemin et nom du fichier image 
End With 
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